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Chapter 1: Installing a Configuration

1.1 Overview: Installing configurations

Introduction

When you install a configuration, its validity and logical completeness is checked. What takes place out-
side IGSS and the relationships to the PLC remain the user’s responsibility. A configuration must be error-
free and approved, before it can be put into operation. The installation module automatically checks the
whole configuration and reports on the installation result.

Many basic control functions are incorporated in the Definition module, such as preventing duplicate
object names, unnamed objects, references to non-existent objects, etc.

Before you begin

Even though the installation module reports any errors encountered during the installation, itis rec-
ommended to go through the following checklist before installing.

o Itis recommended to install the configuration regularly to check your definitions and correct pos-
sible errors. This is not achieved when you use the Save function.

o Is the configuration complete?
« Have you specified an external type for analog, table, digital, counter and string objects?
e Have you supplied PLC addresses for all object atoms (I/0O points) which are not defined as local?
« Have you defined and linked an alarm text to each alarm atom, for example, High Alarm and
Low Alarm for an analog object?
What does the Chelm installation module control?

The Chelm installation module primarily checks the connection to the physical process, internal defi-
ciencies in the configuration and consistency between alarm atoms and alarm texts.

The installation module checks the following.

o Are all PLC addresses specified for object atoms defined as in, out and in/out?

e Are all alarm atoms linked to an alarm text?

The result of the installation is reported on-screen as soon as the installation is complete.

Typical installation errors

The most typical installation errors are:

e Missing external type for analog, table, digital, counter and string objects
e Missing PLC addresses for object atoms defined as in, out and in/out

¢ No alarm text linked to an alarm atom

Installing the configuration
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Installing a configuration is very simple. Do one of the following:

o If the configuration is running, select File — Online Update

o If the configuration is not running, select File — Install Configuration.

In both cases, the Installation Options dialog box appears. _

o If the installation is successful, a message prompt appears informing you of how many objects the
installed configuration holds. From the message prompt, you can access the configuration instal-

lation report (MyConfig.prt).

o Ifthere are any errors in the configuration, the Troubleshooter module appears. By using the
information supplied in this file, you can easily correct any errors and then repeat the installation.

Installation backup files

The latest valid configuration is always backed up in the configuration backup folder, \ZTBackup. If you
are not able to install your configuration, you can always go back to the latest valid version.

1.2 To install a configuration

When you've made changes to a configuration, you must install the changes before the operator can use
the modified configuration. There are two methods available.

If the configuration is running
1. Select File — Online Update.
2. Click Yes to save the changes. The
Installation Options dialog box appears.

3. Change the options, if necessary and click OK.

« If the installation is successful, a message prompt appears informing you how many objects the
installed configuration holds. From the message prompt, you can access the installation report

(MyConfig.prt) by pressing Yes.

o Ifthere are any errors in the configuration, the Troubleshooter module appears assiting you in
correcting the errors.

4. In most cases, you will not want to see the installation report. Press No to allow IGSS to complete
the installation of the configuration and restart the configuration.

If the configuration is not running

1. Select File —» Install Configuration.

2. If you have unsaved changes, you are prompted to save them. Otherwise, the Chelm module is
automatically launched and the Installation Options dialog box appears.

3. Change the options as required and click OK.

o Ifthe installation is successful, a message prompt appears informing you how many objects the
installed configuration holds. From the message prompt, you can access the installation report
(<MyConfig>.prt) by pressing Yes.

o If there are any errors in the configuration, the Troubleshooter module appears assisting you
in correcting the errors.
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4, In most cases, you will not want to see the installation report. Press No to allow IGSS to complete
the installation of the configuration.

5. When installed, start the configuration from the IGSS Starter program. If the program is not
already open, select Start —» Programs — IGSS 8.0 — IGSS Starter.

For details about the properties in the Installation
Options dialog box, click the ?, then click the relevant
item in the dialog box.

Once you have set up the appropriate options, you can
check Skip This dialog box to bypass it when you install
your configuration.
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Chapter 2: Installation Report

2.1 Installation report, MyConfig.prt

The configuration installation report, <MyConfig>.prt, contains the information you enabled in the Instal-
lation Options dialog box.

The following sections can be included in the report:

This section ... shows the following ... Example

Report header e The user-defined headline |Click here for an
for reports defined in Sys- |example.
tem Configuration

¢ the name of the con-
figuration file

o the number of objects in
the configuration and

« text bytes used

Objects sorted by |An alphabetical list of objects Click here for an
name divided into the areas of the con- [example.

figuration. The object type and
description are always shown. If
you want to view all details for
each object, check Detailed
object information in the Instal-
lation Options dialog box.

Objects sorted by |All objects divided into the rel- Click here for an
type evant object type groups (analog, [example.

digital, etc.). There is one list for
each area in the configuration.

Objects sorted by |All PLC addresses sorted by data |Click here for an
PLC address group. Each line shows the precise |example.

address, its length, object name
and atom, scan interval and exter-
nal type.

If a PLC
address is
used more
than once,
Overlap is
noted next

to it. This
will not



../../../Content/PRT-File-Sections/PRT_Report_header.htm
../../../Content/PRT-File-Sections/PRT_Report_header.htm
../../../Content/PRT-File-Sections/PRT_Report_header.htm
../../../Content/PRT-File-Sections/PRT_Report_header.htm
../../../Content/PRT-File-Sections/PRT_Report_header.htm
../../../Content/PRT-File-Sections/PRT_Objects_sorted_by_name.htm
../../../Content/PRT-File-Sections/PRT_Objects_sorted_by_name.htm
../../../Content/PRT-File-Sections/PRT_Objects_sorted_by_name.htm
../../../Content/PRT-File-Sections/PRT_Objects_sorted_by_name.htm
../../../Content/PRT-File-Sections/PRT_Objects_sorted_by_name.htm
../../../Content/PRT-File-Sections/PRT_Objects_sorted_by_type.htm
../../../Content/PRT-File-Sections/PRT_Objects_sorted_by_type.htm
../../../Content/PRT-File-Sections/PRT_Objects_sorted_by_type.htm
../../../Content/PRT-File-Sections/PRT_Objects_sorted_by_type.htm
../../../Content/PRT-File-Sections/PRT_Objects_sorted_by_type.htm
../../../Content/PRT-File-Sections/PRT_Objects_sorted_by_PLC_address.htm
../../../Content/PRT-File-Sections/PRT_Objects_sorted_by_PLC_address.htm
../../../Content/PRT-File-Sections/PRT_Objects_sorted_by_PLC_address.htm
../../../Content/PRT-File-Sections/PRT_Objects_sorted_by_PLC_address.htm
../../../Content/PRT-File-Sections/PRT_Objects_sorted_by_PLC_address.htm
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This section ...

shows the following ...

Example

Objects sorted by
alarms

result in an
error when
you install,
because you

may want
duplicate

addresses
by design.

A section for each alarm number
showing the alarm text and the
objects that use it.

Click here for an

example.

Base classes

Scan classes

List of objects divided into the rel-
evant base classes (defined by the
Base interval on the Data Man-
agement Definitions tab) and
data reduction methods (Mini-
mum, Maximum, etc.).

The driver ID, node nhumber, PLC
address and length for each object
defined in the respective scan
classes (defined by the Scan
interval on the Data Man-
agement Definitions tab).

The Manual
section con-
tains
objects for

which None
was
selected as
scan inter-
val.

Click here for an

example.

Click here for an

example.

Communication
efficiency infor-
mation
Resource usage
(last section)

Click here for details.

The usage of objects, scan rec-
ords, data groups, atoms, alarm
texts and data reduction methods.

The final lines tell you that the con-
figuration is properly installed.

Click here for an

example.

Station and driver
setup

This section of the report shows
the settings defined for all stations
and drivers.

Click here for an

example



../../../Content/PRT-File-Sections/PRT_Objects_sorted_by_alarms.htm
../../../Content/PRT-File-Sections/PRT_Objects_sorted_by_alarms.htm
../../../Content/PRT-File-Sections/PRT_Objects_sorted_by_alarms.htm
../../../Content/PRT-File-Sections/PRT_Objects_sorted_by_alarms.htm
../../../Content/PRT-File-Sections/PRT_Objects_sorted_by_alarms.htm
../../../Content/PRT-File-Sections/PRT_Base_classes.htm
../../../Content/PRT-File-Sections/PRT_Base_classes.htm
../../../Content/PRT-File-Sections/PRT_Base_classes.htm
../../../Content/PRT-File-Sections/PRT_Base_classes.htm
../../../Content/PRT-File-Sections/PRT_Base_classes.htm
../../../Content/PRT-File-Sections/PRT_Scan_classes.htm
../../../Content/PRT-File-Sections/PRT_Scan_classes.htm
../../../Content/PRT-File-Sections/PRT_Scan_classes.htm
../../../Content/PRT-File-Sections/PRT_Scan_classes.htm
../../../Content/PRT-File-Sections/PRT_Scan_classes.htm
sysconfig.chm::/Drv_BCK_Communication_efficiency_information_MyConfig_scn_.htm
sysconfig.chm::/Drv_BCK_Communication_efficiency_information_MyConfig_scn_.htm
sysconfig.chm::/Drv_BCK_Communication_efficiency_information_MyConfig_scn_.htm
sysconfig.chm::/Drv_BCK_Communication_efficiency_information_MyConfig_scn_.htm
../../../Content/PRT-File-Sections/PRT_Resource_usage.htm
../../../Content/PRT-File-Sections/PRT_Resource_usage.htm
../../../Content/PRT-File-Sections/PRT_Resource_usage.htm
../../../Content/PRT-File-Sections/PRT_Resource_usage.htm
../../../Content/PRT-File-Sections/PRT_Resource_usage.htm
../../../Content/PRT-File-Sections/PRT_Station_and_driver_setup.htm
../../../Content/PRT-File-Sections/PRT_Station_and_driver_setup.htm
../../../Content/PRT-File-Sections/PRT_Station_and_driver_setup.htm
../../../Content/PRT-File-Sections/PRT_Station_and_driver_setup.htm
../../../Content/PRT-File-Sections/PRT_Station_and_driver_setup.htm
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Chapter 3: Installation Errors

3.1 Installation log file and the Troubleshooter

The error log file, MyConfig.err, contains information about errors in the configuration.

If there are errors when you install a configuration, the Troubleshooter module will appear.

[ i TroubleShooter [diigss configs\scada projectidemo.ERR] -
File Edit View Tools Help
=M B & L
Object ... AreaM.. ObjectTy.. Object Desc. Atom Err Mo. Err Desc
i Training AMALOG Temperature in burner 020 Prablern with alarm number 0: Alarmn test defintion iz missing or A
i Training  ANALOG Temperature in burner a0 Froblem with alarm number O; Alarm text definition is mizzing or o

Il 1 1
|F|:-r Help, press F1

In this case, the user has forgotten to attach an alarm text to an alarm atom which has been enabled on
the object t1.

To correct the error

1. Double-click the line in the Troubleshooter window. A dialog box appears providing further
details about the error.

2. Click the Locate Error in Definition button. You will be taken to the affected object's dialog box
where you can correct the error.

Dialeg B | S|
Area Mame: Training Object Hame: t1
Object Tupe: ANALOG Object Desc.: Temperature in burner
Drrivver M ame: MNode Mo.:
Err Mo.: 8020 Atarm;
Ern Desc

Problem with alarm number 0 Alarm test definition iz mizsing or Alarm number iz outzide the alarm number range
from 1 to 9993339,

Locate Emar in Definition k.
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3. Correct the errorin the object properties dialog box. In this case, you simply need to attach an
alarm text to the High Limit atom. Notice that the Alarm Details drop-down list is empty - this
caused the error.

tl @ Training - Temperature in b‘u-rrrer - X
[ | Analog I Alamn In/Ack Bit | Layers | Data Management Definitions
Edit Mapping | Calculation | Report Format

Atom PLC Mode for object: t1

viHigh Alarm * | Diver: | 7TMODGPRS (IGSS Servi ~ |

High Limit

[w]Actual Value Mode | 0 1r|

[w]Set Poirt

[CLow Limit PLC Address for High Limit atom:

[w]Low Alam
| [Aam-n M Datatype:  |Holding Register 316~ |
||| ome: Ofset Dec: [0 |

Alarm Details Offzet Hew: |U |

[ d

Bit Oifset

[ New | [ Edt | | Dete | Extemal type | ot sed -
| Ilse numeric +/-to scroll to nesxt/previous atom

ok [ cencel |[ Hep |

4, Correct all errors and repeat the installation until all errors are eliminated.

IGSS will not allow you to start the modified con-

figuration in Supervise, until all errors have been cor-
rected.
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Chapter 4: Dialog Box Help

4.1 Installation Options

What it shows

This dialog box appears when you install a configuration in the Definition module. It allows you to deter-
mine what you want to show in the installation report, MyConfig.prt and a few other options.

If you check Skip This dialog box, the installation will

bypass the dialog box. To show it again, hold down
SHIFT while you select Install Configuration.

How it looks

The figure below shows the Installation Options dialog box.

Installation Options

Inztallation zettings Inztallation report settings
[ ] Do not report emors on missing pictures Sort objects by PLC address
[] Do not report driver setup emors [] 5ot objects by alarm rnumber
[ ]1DoMOT install - show only report [ ] Sort objects by object type
Include these abject types [ ] Show detailed object information
Area Table
Diagram Counter
Graph String
Analog Scale
Crigital Template
[ Skip this dialog ok | [ cancel | | Hel

Correcting installation errors

Errors will be displayed in the Troubleshooter module.

-10 -
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Chapter 5: Reference and Lookup

5.1 Conventions in this Manual

The following typographical conventions are used:

Convention Description Example
User inter- When referring to labels and names
face ele- . . The Data Management tab.
in the user interface.
ment
. When the user has to type specific U2 SR LT C e el
Userinput 1 jata in 1GSS
' Incoming flow in Tank 2
Module . . .
name When referring to a module in IGSS Open the Definition module.
By default, the times-
A note emphasizes or supplements tamp is in universal
important points of the main text. A time format, L
Note . . . .
note provides information that may This can be changed
apply only in special cases. in the Driver Log
Filters dialog box.
A tip suggests alternative methods
that may not be obvious in the user
Tip interface. A tip also helps the user in
working more effectively with IGSS.
A tip is not essential to the basic
understanding of the text.
A warning is an important note that If you disregard the
is essential for the completion of a System alarm, you
Warning task. In some cases, disregarding a may risk loss of data
warning may result in undesirable in the and
functionality or loss of data. files.

5.2 Getting Help in IGSS

IGSS comes with a comprehensive help system designed to help both system designers and operators to
get started with IGSS as quickly as possible.

Documentation overview

lyniversal Time Coordinated (formerly Greenwich Mean Time), used as the basis for calculating time in
most parts of the world. IGSS uses this time format internally in the database. You can switch between UTC
and local time by enabling or disabling the "UTC" field in various dialog boxes in the system.

-11 -
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The IGSS documentation includes the following items:

Documentation item Description

An introduction to IGSS and its most fundamental terms and features.
Getting Started is intended to get you up and running as fast as pos-
sible. The manual provides a system and architecture overview fol-
lowed by a number of real-life use cases you can go through before
building your first real IGSS project. The manual is available in Adobe
Acrobat format (.pdf).

Getting Started

For each module there is a help file with the same name as the mod-
ule itself, for example, Igss.chm for the Master module, Igss.exe.

Module help The help file is invoked by clicking the in the upper right corner of the
module. The Table of Contents will then allow you to browse through
the topics.

For each dialog box there is a help topic with the following standard
information:

e Overview

e Preconditions

e WheredoI find it?
o Field help

Dialog box help

Dialog box help is invoked by clicking the help button in the upper
right hand corner of the dialog box.

IGSS also provides thematic help. When there is a special theme that
requires special attention from the user, a dedicated help file is pro-
vided. Examples include "Driver-Specific Help" and "Database Admin-
istration Help".

Thematic help

Where are the help files located?

The IGSS help files are located in the appropriate language folder under the [IGSS InstallPath]. The help
files are available in English at release time.

The paths to the help files are:

Language Path
English [IGSS InstallPath]\ENG
Danish [IGSS InstallPath]\DAN
German [IGSS InstallPath]\DEU

Translated help files

-12 -
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Selected help files have been translated into Danish and German. If you require help files in your language,
please contact 7T.

Help updates

The IGSS help files are continuously updated and improved. Check regularly with the IGSS Update mod-
ule in the IGSS Start menu.

5.3 Version Information (IGSS Help System)
© 7-Technologies A/S, IGSS Version 8.0

The IGSS help files are based on software build number 9212 (initial release)

English help files

To update the help files, you must activate the IGSS Update module in the IGSS Start menu. There must
be a connection from the PC to the Internet. Every time IGSS Update is run, IGSS help files as well as
IGSS system files will automatically be updated on the PC from the 7-Technologies web server.

You select the languages you want to update in the Tools menu of the IGSS Update module.

If you are not able to update the IGSS system directly via the Internet, the alternative is to download the
updates from the 7-Technologies website as zip files. These can then be transferred onto a CD or USB mem-
ory stick, which is then the medium used to update on site.

After running , the build numbers in var-
ious IGSS modules may change to a higher nhumber.
This signifies that the module in question has been
updated with newer files. Build numbers consist of four

digits, where the first digit represents the year and the
last three represent the day number in the yearin ques-
tion. The build number can be seen in the About dialog
box which can be activated from the Help menu.

An example:

Build number = 9212
9 = the year 2009
210 = The 210th day of the year

-13 -
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Chapter 6: Glossary

A

Application button
The Application button, nicknamed "doughnut", is located in the upper left corner of the module's
window. Click the button to access the application menu. The menu contains items that were typ-
ically found in the File menu in previous versions of IGSS. In most modules, an "Options" item
allows the user to define global module settings. The Application button is a new term introduced
with the .NET platform and used in, for example, the Microsoft Office 2007 package.

H

HDM
HDM is the abbreviation for Hour-Day-Month.

Q

Quick Access Bar
You can customize the Quick Access Bar to include the functions you use most frequently. Simply
drag the relevant function from the ribbon to the Quick Access Bar.

R

Ribbon
The Ribbon is a new term/element in the Microsoft universe. The Ribbon replaces the well-known
toolbars in applications. The Ribbon provides quick access to the most commonly used functions
in the application. The Ribbon is divided into logical groups (the tabs) and each tab is divided into
sections (the blocks in the tab). The Ribbon is context-sensitive which means that only relevant
functions are accessible dependent on the current user action.

S

SCADA
Supervisory Control & Data Acquisition

U

UTC

Universal Time Coordinated (formerly Greenwich Mean Time), used as the basis for calculating
time in most parts of the world. IGSS uses this time format internally in the database. You can
switch between UTC and local time by enabling or disabling the "UTC" field in various dialog boxes
in the system.

-14 -
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